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HARDWARE WARRANTY
Limited Warranty. Rigel Corporation warrants, for a period of sixty (60) days from your receipt, that READS software, 
RROS, hardware assembled boards and hardware unassembled components shall be free of substantial errors or 
defects in material and workmanship which will materially interfere with the proper operation of the items purchased. 
If you believe such an error or defect exists, please call Rigel Corporation at (352) 384-3766 to see whether such 
error or defect may be corrected, prior to returning items to Rigel Corporation. Rigel Corporation will repair or replace, 
at its sole discretion, any defective items, at no cost to you, and the foregoing shall constitute your sole and exclusive 
remedy in the event of any defects in material or workmanship. Although Rigel Corporation warranty covers 60 days, 
Rigel shall not be responsible for malfunctions due to customer errors, this includes but is not limited to, errors in 
connecting the board to power or external circuitry. This warranty does not apply to products which have been subject 
to misuse (including static discharge), neglect, accident or modification, or which have been soldered or altered 
during assembly and are not capable of being tested.
DO NOT USE PRODUCTS SOLD BY RIGEL CORPORATION AS CRITICAL COMPONENTS IN LIFE SUPPORT 
DEVICES OR SYSTEMS!
Products sold by Rigel Corporation are not authorized for use as critical components in life support devices or 
systems. A critical component is any component of a life support device or system whose failure to perform can be 
reasonably expected to cause the failure of the life support device or system, or to affect its safety or effectiveness.
THE LIMITED WARRANTIES SET FORTH HEREIN ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE.
YOU ASSUME ALL RISKS AND LIABILITY FROM OPERATION OF ITEMS PURCHASED AND RIGEL
CORPORATION SHALL IN NO EVENT BE LIABLE FOR DAMAGES CAUSED BY USE OR PERFORMANCE, FOR 
LOSS PROFITS, PERSONAL INJURY OR FOR ANY OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES. 
RIGEL CORPORATION'S LIABILITY SHALL NOT EXCEED THE COST OF REPAIR OR REPLACEMENT OF 
DEFECTIVE ITEMS.
IF THE FOREGOING LIMITATIONS ON LIABILITY ARE UNACCEPTABLE TO YOU, YOU SHOULD RETURN  ALL 
ITEMS PURCHASED TO RIGEL CORPORATION PRIOR TO USE.
Return Policy. This policy applies only when product purchased directly from Rigel Corporation. If you are not 
satisfied with the items purchased, prior to usage, you may return them to Rigel Corporation within thirty (30) days of 
your receipt of same and receive a full refund from Rigel Corporation. This does not apply to books. Books are non-
returnable.
Please call (352) 384-3766 to receive an RMA (Returned Merchandise Authorization) number prior to returning 
product. You will be responsible for shipping costs.  All returns must be made within 30 days of date of invoice and be 
accompanied by the original invoice number and a brief explanation of the reason for the return.   Return 
merchandise in original packaging.  All returned products are subject to a $15 restocking charge. "Custom Items" are 
not returnable.
Repair Policy. If you encounter problems with your board or software after the 60 day warranty period, please call 
Rigel Corporation at (352) 384-3766 or email techsupport@rigelcorp.com for advice and instruction.
Rigel Corporation will test and attempt to repair any board. You will be responsible for shipping costs and repair fees. 
If you send a detailed report of the problems you encountered while operating the board, Rigel Corporation will 
inspect and test your board to determine what the problem is free of charge. Rigel Corporation will then contact you 
with an estimated repair bill. You will have the choice of having the board fixed, returned to you as is, or purchasing a 
new board at a reduced price. Rigel Corporation charges repair fees based on an hourly rate of $50.00. Any parts 
that need to be replaced will be charged as separate items. Although Rigel Corporation will test and repair any board, 
it shall not be responsible for malfunctions due to customer errors, this includes but is not limited to, errors in 
connecting the board to power or external circuitry. 
Board Kit. If you are purchasing a board kit, you are assumed to have the skill and knowledge necessary to properly 
assemble same. Please inspect all components and review accompanying instructions. If instructions are unclear, 
please return the kit unassembled for a full refund or, if you prefer, Rigel Corporation will send you an assembled and 
tested board and bill you the price difference. You shall be responsible for shipping costs. The foregoing shall apply 
only where the kit is unassembled. In the event the kit is partially assembled, a refund will not be available, however, 
Rigel Corporation can, upon request, complete assembly for a fee based on an hourly rate of $50.00. Although Rigel 
Corporation will replace any defective parts, it shall not be responsible for malfunctions due to errors in assembly. If 
you encounter problems with assembly, please call Rigel Corporation at (352) 384-3766 for advice and instruction. In 
the event a problem cannot be resolved by telephone, Rigel Corporation will perform repair work, upon request, at the 
foregoing rate of $50.00 per hour.
Governing Law. This agreement and all rights of the respective parties shall be governed by the laws of the State of 
Florida.



Rigel Corporation’s Software License Agreement
This Software License Agreement ("Agreement") covers all software products copyrighted to Rigel Corporation, 
including but not limited to: Reads51, rLib51, RbHost, RitaBrowser, rFLASH, rChipSim, rP51, Reads166, and rFLI. 
This Agreement is between an individual user or a single entity and Rigel Corporation. It applies to all Rigel 
Corporation software products. These Products ("Products") includes computer software and associated electronic 
media or documentation "online" or otherwise.
Our software, help files, examples, and related text files may be used without fee by students, faculty and staff of 
academic institutions and by individuals for non-commercial use. For distribution rights and all other users, including 
corporate use, please contact:

Rigel Corporation, PO Box 90040, Gainesville, FL 32607
E-mail: techsupport@rigelcorp.com

Terms and Conditions of the Agreement
These Products are protected by copyright laws, intellectual property laws, and international treaties. Rigel 
Corporation owns the title, copyright, and all other intellectual property rights in these Products. We grant you a 
personal, non-transferable, and non-exclusive license to use the Products. These Products are not transferred to you, 
given away to you or sold to you.

Non-commercial use: These Products are licensed to you free of charge.

Commercial use: You must contact Rigel Corporation to find out if a licensing fee applies before using these 
Products.

You may install and use an unlimited number of copies of these Products.

You may store copies of these Products on a storage device or a network for your own use.

You may not reproduce and distribute these Products to other parties by electronic means or over computer or 
communication networks. You may not transfer these Products to a third party. You may not rent, lease, or lend these 
Products.

You may not modify, disassemble, reverse engineer, or translate these Products.
These Products are provided by Rigel Corporation "as is" with all faults.

In no event shall Rigel Corporation be liable for any damages whatsoever (including, without limitation, damages for 
loss of business profits, business interruption, loss of business information, or other pecuniary loss) arising out of the 
use of or inability to use the Product, even if Rigel Corporation has been advised of the possibility of such damages. 
Because some states do not allow the exclusion or limitations of consequential or incidental damages, the above 
limitations may not apply to you.

Rigel Corporation makes no claims as to the applicability or suitability of these Products to your particular use, 
application, or implementation.

Rigel Corporation reserves all rights not expressly granted to you in this Agreement.

If you do not abide by or violate the terms and conditions of this Agreement, without prejudice to any other rights, 
Rigel Corporation may cancel this Agreement. If Rigel Corporation cancels this Agreement; you must remove and 
destroy all copies of these Products.

If you acquired this Product in the United States of America, this Agreement is governed by the laws of the Great 
State of Florida. If this Product was acquired outside the United States of America, all pertinent international treaties 
apply.
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1 OVERVIEW
The R-420SP is very low-cost programmer and chip carrier for the DS89C4X0 microcontroller in the 44-
pin PLCC package.  It contains a clock oscillator, a reset chip, and an RS-232 level converter.  These 
support chips allow the microcontroller to be programmed and run in the single-chip mode.  That is, the 
board will run code from internal ROM, using the on-chip RAM.  The R-420SP complements the line of 
MCS-51 single-chip mode products from Rigel Corporation.  This line includes the R-51SP, R-51SD, the 
programming and prototyping board R-51PB and Reads51, Rigel’s Integrated Development Environment, 
with a C compiler, and assembler, and a linker.  Reads51, build 448, now supports code generation for 
the single-chip mode and on-board programming of the DS89C4X0 using the R-420SP board.

The R-420SP is intended to be embedded into the end product.  Connections to the R-420SP may be 
made through sockets, headers, or straight soldering into the ports.  All integrated circuits except the 
reset chip are socketed.  This makes the R-420SP disposable, as the expensive components may be 
removed and used over again.  Moreover, the clock frequency is determined by a socketed oscillator chip. 
This way, the clock frequency may be changed simply be replacing this chip.
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2 SOFTWARE DEVELOPMENT AND PROGRAMMING THE ROM
Code may be downloaded into the ROM of the microcontroller while it is on-board the R-420SP.  The 
Reads51 integrated development environment (IDE) may be used for code development and 
programming the R-420SP.   Rigel Corporation also offers a programmer board, the R-51PB, specifically 
designed to program the ROM on 8051-family microcontrollers to be used for debugging code.  
2.1 System Requirements 
All of Rigel’s software is designed to work with an IBM PC or compatible, Pentium 120MHz or better, 
running Windows 95, 98, 2000, ME, NT, or Windows XP.  The newest versions of our software are always 
available to download off our web site, www.rigelcorp.com.  We encourage you to check our web site 
often to keep up-to-date.
2.2 Software Installation
If you receive a CD from Rigel, follow these steps:
Place the CD-ROM in your drive.  
Go to the Rigel Products | 8051 Software and click on the .exe file you wish to install.  The program will 
then install in your system.  Follow the standard install directions.

If you download Rigel software from the web, (www.rigelcorp.com), follow these steps:
Click on the.exe file you downloaded.
The program will then install in your system.  Follow the standard install directions.
2.3 Reads51
Reads51 is an integrated development environment (IDE) that has a source code editor, an assembler, a 
Small-C compatible compiler, and an OMF-51 linker.  Reads51 (build 448) allows you to download 
directly to the R-420SP from the TTY window.  Refer to the R-420SP user's manual for details.
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3 BOARD CONNECTIONS
The connections to the R-420SP board are made through the terminals placed along the peripheral of the 
boards.  These terminals may be left as open holes and the application signals may be directly soldered 
to the terminals.  Alternatively, the terminals may be populated by headers or sockets, and the application 
signals may be applied through mating connectors. The headers or sockets may be connected from the 
top or the bottom of the boards.  These options are intentionally left open to provide the maximum level of 
flexibility in the physical assembly of the final product.  

The connections to the boards may be classified into three categories: power connections, serial 
communications signals, and port connections.  These categories are presented below.  There are 
several alternate ways to connect the R-420SP board to the application.  Refer to the board when 
considering these options.  Only power and serial communications connections are needed to program 
and run the board.   See Diagram.

3.1 Power Connections
The R-420SP board requires a well-regulated 5Volt DC supply.  There are several VCC (+5V) and GND 
(ground) terminals available on the board.  The ones on the lower left corner, header J6, marked “(-)” and 
“(+)” are perhaps the most convenient place to supply the power.  In addition, the port terminals placed 
along the two longer sides of the board terminate with power posts.  This is convenient if a single harness 
for power and port signals is to be used.  Similarly, the serial communications signals at the dedicated 
terminal J1 terminate with power posts.  Again, a single harness carrying power and the serial 
communications signals may be used. For mobile applications, you may use four 1.5V batteries in series 
to generate a 6V DC supply.  Then use one or two diodes in series to drop the voltage.
3.2 Serial Communications Signals
There are two serial ports on the board.  Each serial port uses three lines: receive (RxD), transmit (TxD), 
and ground (GND or G).  R0 and T0 are connected to serial port 0 of the DS89C4X0 microcontroller.  R1 
and T1 are used with serial port 1 of the microcontroller.  Two headers, marked R1 and T1 on the board 
must, be populated to use serial port 1.  When these jumpers are removed, the port pins P1.2 and P1.3 
may be used as general-purpose ports.

Serial port signals are available on headers J4 and J5 on the extreme right-top and right-bottom of the 
board as two triplets: “R0-T0-G” and “R1-T1-G.”  Serial port signals are also available on the six-position 
terminal (J1), placed on the left edge.  A square pad marks pin 1 of J1.  The terminal signals are given 
below:
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Position Signal Remark

1 VCC (+5 VDC) Square pad
2 RxD0
3 TxD0

Serial port 0

4 GND (Ground)
5 RxD1
6 TxD1

Serial port 1

 
3.3 Input/Output Ports
The R-420SP input/output ports are directly connected to the ports of the microcontroller.  The MCS-51 
ports are quasi-bi-directional ports.  They use pull-up resistors to be at logic level high.  When used as 
inputs, the external signal must ground the port for the microcontroller to read a logic level low.  Refer to 
the 8051 data books for more information.  Several examples are also provided in the textbooks by Rigel 
Press (see references).

The four ports of the 89C4X0 are available on the top and bottom edges of the board.  There are eight 
terminals for each of the ports P0 to P3.  A square pad indicates Port bit 0 for each port.  In addition to the 
port bits, each side has an additional terminal for VCC (marked ‘V’) and serial port signals, including the 
ground (marked ‘G’) signal.
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4 PROGRAMMING 
4.1 Reset
The R-420SP board uses a dedicated reset chip, the DS1812.  The board is reset upon power up.  Cycle 
the power (turn the power off and then on again) to induce a reset.
4.2 Programming the DS89C4X0
The board is placed in the program mode by moving the slide switch (S1) to the upper position marked 
“<PRG>.”  Once the board is programmed the switch should be moved to the operating position marked 
“<RUN>” and the power cycled.
 
Refer to the C-language examples in Reads51 to see how the internal XDATA RAM of the DS89C4X0 is 
enabled.  Once you develop your code, you may download it to the board using the Reads51 TTY 
window.  Place the board in the program (PGM) mode and press the “enter” key.  The DS89C4X0 internal 
“ROM LOADER” monitor program answers with a prompt.  Note that the DS89C4X0 monitor extracts the 
Baud rate from the received character.  Refer to the DS89C4X0 data sheet to see what Baud rate – 
crystal frequency combinations are supported.  In general, an 11.0592MHz crystal frequency supports 
almost all Baud rates.
 
Once the internal monitor program answers with the prompt, use the monitor command ‘K’ to erase 
internal memory.  That is, press ‘K’ and enter.  Refer to the DS89C4X0 data sheet for a complete set of 
monitor commands.  Then enter the load command ‘L’ (and enter).  This places the monitor in the 
download state.  It expects code in the Intel Hex format.  Use the Reads51 “Tools -> Download ASCII file” 
command to download your program to the board.  Note that the “Options->TTY Options” dialog has three 
fields related to the ASCII downloads.  You may specify a delay after each character and each line of 
ASCII text.  (The hex file is ASCII text.)  You may also instruct the Reads51 down-loader to wait for an 
acknowledgement character before sending the next line of text.  The DS89C4X0 monitor returns a ‘G’ 
(for good record) when it is ready for the next line.  It is recommended that you set the character delay to 
0 (no delay). 

Use the Reads51 to communicate with the board.  Note that the 89C4X0 internal XDATA RAM is only 1K. 
The settings below reserve the first 256 bytes (0x100) for global variables, and the remaining 768 bytes 
(0x300) for the C-stack.  That is, the C-stack starts at 0x100.
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Include a start-up module in your project.  This module must be named “c0.src.”  Enable the internal 
XDATA RAM in the start-up code.  That is, set the PMR (0xC4) to 1.  The project R-420SP shows the 
compiler and linker settings.  It also includes the start-up code.
4.3 Downloading HEX Code to the DS89C4xx Microcontrollers
The menu item "Download ASCII File" in the "Tools" menu can be used to send generated HEX code to 
the DS89C4xx microcntrollers.  

These microcontrollers have a built-in monitor program called the "ROM Loader." The microcntroller must 
be placed in the so-called "ROM Loader Mode" by selecting the appropriate hardware signals.  The Rigel 
boards usually have a slide switch that allows you to toggle between the modes.  On the Rigel boards, the 
two modes are referred to as the "Program (or Pgm)" and "Run" modes.  

Once the microcntroller is in the PGM mode, it communicates through its serial port (SP0).  The on-chip 
monitor detects the communications Baud rate from the characters it receives.  In Reads51, open the 
TTY window and select a suitable Baud rate. The on-chip monitor (ROM Loader) expects a carrige return 
character.  Press the "Enter" key.  If the monitor can match the Baud rate, it responds with a prompt 
message.  Note that although a broad range of Baud rates are supported, some Baud rates may not work 
at certain crystal frequencies.  Usually, trying a different Baud rate solves the problem.  Refer to the data 
sheet for more information on exactly which Baud rates are detected at different crystal frequencies.

Once the monitor (ROM Loader) is invoked, the remaining operations are carried out by a series of 
commands.  Again refer to the data sheet for a complete set of commands.  Below, we summarize the 
most important three commands.
4.3.1 Clear FLASH
At the monitor prompt, press 'K' and "Enter" to clear the internal FLASH.  The FLASH should be erased 
before loading a new Hex file.  Clearing the FLASH also clears the security bits (Lock Bits or LB).
4.3.2 Download HEX File
At the monitor prompt, press 'L' and "Enter" to initialize a download session.  The monitor expects to 
receive Intel Hex records.  At this point, use the "Download ASCII File" menu to specify a HEX file.  The 
menu item is under the "Tools" menu.  Once you specify a HEX file, the transmission starts.  

The monitor acknowledges the reception and successful programming of a record by a 'G' character.  You 
may use the TTY options dialog (from the "Options" menu, select "TTY Options") to specify 'G' as the 
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"Line ACK  char."  This improves transmission speed.  If you use another TTY program such as the 
WIndows HyperTerminal, make sure you insert enough delays after each line to allow for FLASH 
programming time.

At the end of the transmission, the monitor will once again display its prompt.
4.3.3 Setting the Security Bits
Use the 'W' command to set the security bits LB1, LB1+LB2, or LB1+LB2+LB3.  These bits provide 
increasing levels of security, as explained in the data sheet.  The "Lock Bits" LB are bit mapped.  LB1 is 
the least significant bit, while LB3 is the most significant.  A value of 3, for instances, sets LB1 and LB2. 
The following are permissible combinations:

Command : "W LB 1 <enter>"
Command : "W LB 3 <enter>"
Command : "W LB 7 <enter>"
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5 Parts List
 Quantity Part Mouser Part Number  Designator

3 10nF PCC103BCT-ND C6, C7, C8
4 1uF 140-MLRL50V1.0 C1-C4
1 47uF 140-MLRL50V1.0 C5
    
1 10K gang 266-10K R1
    
2 1N4001 / 1N4148 583-SM4001 / 621-MMBD4148 D1, D2
    
3 1X2 Header 100mil T1/J2, R1/J3, J6
1 1X6 Header 100mil J1
2 1X20 Header 100mil J4, J5
    
1 16 Pin Dip Socket 575-199316 U1
1 44 Pin PLCC 575-442494 U2
1 8 Pin Dip Socket 575-199308 U3
    
1 MAX232 MAX232CPE U1
1 DS89C4X0 DS89C4X0MNG U2
1 Clock 11.0592 / 12 / 24 MHz U3
1 DS1812 DS1812-10 U4
    

  Part #'s in Bold are Surface Mount Parts populated on the bottom of the board
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6 Top Overlay

Bottom Overlay
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